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ABSTRACT 
The intention of this paper is to reduce human victims in terrorist attack. So this problem can be overcome 

by designing the RF based spy robot which involves wireless camera.  So that from this we can ex-amine 

rivals when it required. This robot can quietly enter into enemy area and sends us the information via wireless 

camera. On the other hand one more feature is added in this robot that is color sensor. Color sensor senses the 

color of surface and according to that robot will change its color. Because of this feature this robot can’t 

easily detected by enemies. The movement of this robot is wirelessly controlled by a hand held RF 

transmitter to send commands to the RF receiver mounted on the moving robot 

 

KEYWORDS: RF, spy robot, wireless camera and color sensor. 

1. INTRODUCTION 
With the aim of developing a high-tech technology that serves high speed technology, advanced capacity to 

control the robots and to device new methods of control theory[1]. The realize above standards some technical 

improvement along with the need of high  performance  robot  is  required  to  create  a  faster,  reliable,  

accurate  and  more intelligent  robot  which can be devised  by advanced  control algorithm,  robot  control 

devices and new drivers. Earlier the robots were controlled through wired networks but now to make robot 

more users friendly, they are framed to make user commanded work. Therefore to attain the requirements we 

can use android as a multimedia to control the user friendly robot [2]. The design of our project encourages 

developing a robotic vehicle based on RF technology for the remote operation connected with the wireless 

camera mounted on the robot for monitoring purpose [3]. 

 

The robot is embedded with 8051 series microcontroller for desired operation and is generally used for spying 

purposes.  The transmitting  module  consist  of the  push buttons that send the commands to the receiving 

module for controlling the movement of robot either to right, left, forward, downward. In the receiving module 

of the robot two motors are interfaced with the 8051 series of microcontroller to control its movement via motor 

driver IC [4].  The remote control (RF transmitter) has a range of 50m that transmits the signals to the RF 

receiver. The receiver collects and decodes the received signals before feeding it to the microcontroller to drive 

the DC motors via motor drivers. The wireless camera used for spying purpose also serves in complete 

darkness using IR lightning [5]. 

 

The distinct applications of this concept in such robot can be a smart phone controlled robots where the 

movement of the robot is controlled by a robot on the basis of android platform.  Smart  phone  transmits  the  

AT  commands  and  data  to  the  8051 controller and controls the motor by motor driver L923D. The robot 

motions left, right, forward, backward. Interfacing is being done between device and Bluetooth. Bluetooth 

device   HC-05 module   receives   the   commands   from   smart   phone   via   8051 microcontroller. 

Component technologies used are (a) RF technology (b) C language (c) Embedded system. 
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2. INTRODUCTION TO EMBEDDED SYSTEMS 
The microprocessor-based system is built for controlling a function or range of functions and is not designed to 

be programmed by the end user in the same way a PC is defined as an embedded system. An embedded system 

is designed to perform one particular task albeit with different choices and options. 

 

Embedded systems contain processing cores that are either microcontrollers or digital signal processors. 

Microcontrollers are generally known as "chip", which may itself be packaged with other microcontrollers 

in a hybrid system of Application Specific Integrated Circuit (ASIC). In general, input always comes from a 

detector or sensors in more specific word and meanwhile the output goes to the activator which may start 

or stop the operation of the machine or the operating system [6]. 

 

An embedded system is  a combination of both hardware and  software,  each embedded system is unique 

and the hardware is highly specialized in the application domain. Hardware consists of processors, 

microcontroller, IR sensors etc. On the other hand, Software is just like a brain of the whole embedded system 

as this consists of the programming languages used which makes hardware work[7]. 

 

As a result, embedded systems programming can be a widely varying experience. An embedded system is 

combination of computer hardware and software, either fixed incapability or programmable, that is specifically 

designed for particular kind of application device[8]. Industrial machines, automobiles, medical equipment, 

vending machines and toys (as well as the more obvious cellular phone and PDA) are among the myriad 

possible hosts of an embedded system. Embedded systems that are programmable are provided  with a 

programming  interface,  and  embedded  systems programming  id specialized occupation[9]. 

 

Existing system 
Unlike most related systems which use remote controllers that communicate with robot. Communicates with 

robot through Bluetooth signal. This approach is better because Android Devices in the form of smart phones 

and tablets are very portable and widely used. The robot can be controlled from any Android device if the 

passkey for pairing is known, so it will not be a Problem even if the Android device is not working. In 

the existing system, when the switch of the robot is turned on, the battery powers on the Adriano  board  which  

is  connected  with  L293Dmotor  driver  and  HC-05  Bluetooth module. After pairing the Android device with 

the module, when the user presses control buttons on the Android application, the corresponding string is 

transmitted to the module. The module receives the string and the Arduino’s microcontroller processes the string 

for the motor driver to drive the DC motors according to the code uploaded to it. 

 

 
Fig.1Block Diagram of Existing System 

 

Bluetooth is a short range wireless communication technology that allows devices such as mobiles in a 

particular range of 2.4 GHz. Exchange the data between fixed distances using short length UHF Radio waves 

in the industrial,  scientific  and  Medical  radio  bands,  and  from100  meters. it  has  slow  data speeds, poor 

data security and shortest battery life. 

 

 

http://www.ijesrt.com/
http://creativecommons.org/licenses/by/4.0/
http://creativecommons.org/licenses/by/4.0/


  ISSN: 2277-9655 

[Vadde * et al., 8(5): May, 2019]  Impact Factor: 5.164 

IC™ Value: 3.00  CODEN: IJESS7 

http: // www.ijesrt.com© International Journal of Engineering Sciences & Research Technology 

 [107] 

    
IJESRT is licensed under a Creative Commons Attribution 4.0 International License. 

Proposed system 
Radio frequency refers to the rate of oscillation of the Electro-magnetic Radio waves range of 30kto 

300Ghz.The intention of this paper  is to reduce human victims in terrorist attack. So this problem can be 

overcome by designing the RF based spy robot which involves wireless camera. So that from this we can ex-

amine rivals when it required. 

 

This robot can quietly enter into enemy area and sends us the information via wireless camera. On the other 

hand one more feature is added in this robot that is color sensor. Color sensor senses the color of surface 

and according to that robot will change its color. Because of this feature this robot can’t easily detected by 

enemies. The movement of this robot is wirelessly controlled by a hand held RF transmitter to send 

commands to the RF receiver mounted on the moving robot. 

 

3. SOFTWARE IMPLIMENTATION 
1.   Every time before uploading code, connect boot0 to  3V3 and press the reset button 

2.   When done with code uploading, connect boot0 to GND. 

 

If you don’t want to use FTDI to upload code and use the microusb port of the blue Pill board instead, you 

have to flash a boot loader inside the STM32F103C8T6. By doing so, you don’t have to connect boot0 pin to 

3v3 for uploading code. And there will be no need to press the RESET button every time before uploading a 

code. 

1.   Download demonstrator gui (STM32 flasher) from this link. You have to create a free account to 

download. Install the software when downloaded. 

2.   Keep your blue Pill board connected to PC via the FTDI and keep boot0 pin connected to 3V3. 

Press the RESET button. 

3.   Open STM Flash Loader Demo (demonstrator gui) executable file. Select 115200 

Baud rate and select the FTDI COM port. Leave all other settings as default. 

4.   Press NEXT and It will automatically detect the blue pill 

5.   Press     NEXT     twice     and     you     be     at     the     following     window 

 

 
 

6. Select   download   to   device   and   browse   (orange   arrow)   to   select generic_boot20_pc13.bin file. 

You will find it under the STM32duino_bootloader folder that you downloaded from media fire. 
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7.   Select Bin Files (red arrow) if the boot loader file doesn’t show up. Press Open. 

8.   Press NEXT when the boot loader file is loaded and the file will be downloaded to Blue pill board. Close 

demonstrator gui (STM32 flasher) when done. 

9. Open y o u r  a r d u i n o  s k e t c h b o o k  f o l d e r .  Then o p e n   Arduino_STM32 folder>drivers>win and 

run “install_drivers.bat” as administrator (right click o n file, then select run as administrator). Press any key 

to close when done. 

Then run “install_STM_COM_drivers.bat” as administrator, too. 

10. Connect boot0 to GND, disconnect FTDI board and connect a microUSB cable (android data cable) 

to Blue pill. Press the RESET button before connecting to PC. 

11. You’ll find windows installing driver for the Blue pill when you connect it to PC using the on board 

microUSB. Eventually a driver named as “maple DFU” will be installed. You can find it inside windows 

Device Manager>libusb>maple DFU. Note that there will be no 

COM port assigned to Blue pill board. That’s normal. 

12. Open arduino IDE. Go to Tools>board> Generic STM32F103C Series. Then go to 

Tools>Variant>STM32F103C8T6 (20k ram, 64k flash). Go to tools> upload method>STM32duino    boot    

loader.    Now    open    the    blink    code    from File>Examples>Basic>blink. 

13. Go  to  tools>port  and  make  sure  no  port  is  selected  or  the  port  option  is deactivated. 

14. Hit the upload button. As soon as “uploading” message appears at the bottom of arduino IDE, press the 

RESET button of Blue pill board. 

15. If your code uploads successfully, you’ll find that windows is installing a new 

driver and this time it will assign a COM port for your Blue pill board. 

16. Go to tools>port and select the correct COM port for Blue pill. The COM port can be found on windows 

Device Manager> ports (COM & LPT)> Maple Serial (correct port). 

17. You have to make sure that the correct COM port is selected to ensure code uploading from now 

on. The STM32duino boot loader is called perpetual boot loader. It works on DFU mode at first without 

using any COM port. After the first program is uploaded, it assigns COM port for the computer. 

18. You are now ready to use Blue pill board as normal arduino board by using the on board microUSB. 

Keep Boot0 and Boot1 pin always connected to GND. You don’t have to press RESET button while 

uploading code anymore. 

 

4. BLOCKDIAGRAM 
The below block diagram’s show the transmitter section and Receiver section. 
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Transmitter section 
 

 
Fig. 2 Block diagram of transmitter 

 

Receiver section 

 

 

 
Fig. 3 Block diagram of Receiver 

 

5. 3STM32F103C8T6 BLUE PILL ARDUINO  
For beginners it might be difficult to use the popular and cheap blue pill board based on STM32F103C8T6. It’s 

because using an embedded development tools like KEIL isn’t easy for beginners. This 32 bit microcontroller 

based on ARM Cortex-M3 architecture is far better than your traditional arduino board. 

 

You can compare it to Arduino DUE but it has got a very small size like the arduino Nano. There’s lack of 

proper documentation on it and everything available in the internet is quite scattered. So, here’s something to get 

you started easily. 

 

STEPS: 
 First download all the resources from this mediafire link. The password for extracting data from the 

zip file is: techshopbd. 

 Open resource STM32 bluepill folder. Copy the Arduino_STM32 folder to your sketchbook 

folder/hardware. Go to arduino IDEs file>preferences and you’ll find the location of your 

sketchbook folder. If there’s no hardware folder, create one named as “hardware” (all lowercase 

letter).Your arduino IDE is now ready for Blue pill. 
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 Have a look on the pinout diagram on the next page. There are 2 yellow colored jumpers beside the 

usb port. They are boot options. Connect boot0 pin to 3V3 and boot1 pin to 

 GND to start the board in SPI mode when it’s powered up or the reset button is 

 pressed. 

 Now connect a FTDI board (FT232RL) to blue pill. You can use any of this or this or this. Connect 

FTDI TX to blue pill RX1 (PA10) and FTDI RX to blue pill TX1(PA9). 

 Connect GND. If your FTDI power pin is 5V, connect it to the 5v pin of Blue pill board. If it’s 3.3 

volt, connect to the pin marked as 3.3. Connecting 5v to any 3.3v pin of Blue pill board will 

permanently damage it. 

 

 
Fig 4:STM32F103Pinout diagram 

 

 Connect the FTDI board to your PC using USB port. You must install the FTDI driver to your PC to 

use the FTDI board. You’ll find enough resources on the internet on this. FYI, it’s the driver for 

arduino Nano. 

 close arduino IDE if it’s open. Then open it. Go to Tools>board> Generic STM32F103C  Series.  

Then  go  to  Tools>Variant>STM32F103C8T6  (20k  ram,  64k flash). These new options for 

STM32 will be automatically added to arduino if you’ve performed everything described it step 2 

successfully. 

 Go to tools> upload method>serial. Then tools>port and select the port of the FTDI 

 Go to tools>board> Boards manager and check if “Arduino SAM Boards (32 bit 

 ARM Cortex M3)” is installed or not. If not, select more info and an install button will appear. 

Install the board definitions. It’s necessary because codes for the Blue pill board 

 uses some files written for Arduino Duo for successful compilation 

 Now open the blink code from File>Examples>Basic>blink. Press the reset button on the Blue pill 

board and hit upload button on the Arduino IDE. (board built -in LED is on PC13) 

 Note that you have to reset the Blue pill board every time you are about to upload code. 

 You will find all other Examples for the Blue pill board under Up button beneath tools 

option>hardware>Arduino_STM32. 

 

Working procedure 

The wireless night vision camera embedded on the robot consists of a wireless transmitter. A cluster of IR 

LEDs are placed which are used to provide IR light to the image sources. The reason IR light is preferred is 

because at night time, it is usually dark and since any camera needs light for illumination, infra red light is the 

most preferred option as all objects emit a range of Infra red light. The camera is powered with a 12 V 

battery and captures these images and transmits them to the receiver unit connected to a Television unit. The  
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images are converted to digital signals by the transmitter unit and the receiver  unit  receives these digital 

signals and  reconverts them to  images and  these images or videos are then monitored and analyzed on a 

Television unit. 

 

 
Fig: 5 Block Diagram Showing Basic Working of the Robot with Night Vision Camera 

 

6. CONTROLLING THE WAR FIELD SPYING ROBOT 
The transmitter unit consists of an encoder which receives parallel data input from the microcontroller through 

the push buttons and transmits this parallel data in serial format through the RF module. On pressing the 

respective push button, Microcontroller is programmed  to  send  relevant  signals  to  the  Encoder  in  parallel  

form.  The encoder converts these parallel signals to serial form to be transmitted by the RF module. This 

serial data is modulated with a carrier signal using a RF transmitter and is transmitter. For example if we 

press the left button, the microcontroller sends the command to the receiver unit through the encoder and the 

RF module. 

 

The  receiver  unit  consists  of  a  RF  receiver  module  which  demodulates  the received signal and a 

decoder which receives the serial data through the RF receiver module and converts it into parallel form. 

The microcontroller uses this   data to give appropriate control signal   to the motor driver IC to control the 

operation of the two motors. Thus the robot can be moved forward or in reverse direction by controlling the 

motor, while the camera does its work simultaneously. 

 

7. RESULT 
With the help of this we aimed at obtaining the accuracy. It has been tested to best of our ability. We were 

able to view the things accurately that were happening. In our view. Our design has not caused any sort of 

disturbances. This robot will move based on the motor direction depending upon the input we give through 

command via remote section unit. With the help of camera we are able to view the things that are happening 

in the war  field  where  the  robot  is  hidden.  The imp or t ing   and  exporting  features  of„ AUDACITY‟ 

in this project have helped to remove the unwanted audio signals. By using this software post process all 

type audio including broadcast by adding effects such as normalizing, trimming fading in and fading out. 
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Fig 6: Transmitter section 

 

Above figure consisting of four buttons left, right, forward, backward .we are given left as input encoder 

encodes the data and send to the receiver. Receiver receives the input and robot moves left. As well as right, 

backward and frontwards process also same. 

 

 
Fig7: Receiver section 

 

 

Applications 
 The main purpose for designing this robot is that to implement it in defense sector to sense 

human fetch for it. 

 The sensor with very high frequencies are required to install this robot in the IT industries 

 This robot can be installed in banks, especially in the places where jewels are kept (locker area). 

 In the educational institutions, this robot can play a vital role in the areas of library and laboratory 

where valuable equipments are kept. 

 Military operations. 

 Surveillance along border. 

 Maneuvering in hazardous environment. 
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Advantages 
 Code compatibility and expandability across different Nucleo boards 

 Cost is less as Nucleo is open source 

 The schematic of Nucleo is open source. So for future enhancement of the project the board  can 

be extended to add more hardware features 

 Wireless control 

 Takes in use of the mobile technology which is almost available everywhere. 

 This wireless device has no foundation of range and can be controlled as far as network of cell 

phone. 

 

8. CONCLUSION 
The project was come out with the operations of Receiver and transmitter circuit. The functions and the 

operations of the circuits interrelated are very important to be analyzed. Currently Wireless controlled Omni 

The main motive of the RF based robot was to make it user friendly. The robot can easily move, capture 

images and wirelessly transmit them. The robot will move depending on the motor direction based upon 

the input we give through transmitter (remote) section. RF signals are used as control signals. By using these 

signals encoding is done & signal is sent through the transmitter. At the receiver end, these decoded signals 

are given as input to drive the motor. The robot is used for short distance surveillance thus ensuring the 

security of the region. This helps the forces to view the things accurately that are currently happening in the 

surrounding area and to plan ahead accordingly. Thus we should be able to manipulate its path when necessary, 

to create the robot safely directional monitoring robot with video support that can monitor using webcam. 
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